
 
 

NHDOT CAD/D Connect Documentation 

ORD Survey Documentation Page 1 of 25 Last edited:  May 7, 2024 

CONNECT DOCUMENTATION 
 

Connect Edition Introduction 

MicroStation Connect Documentation 

OpenRoads Designer Documentation (Survey) 

OpenRoads Designer Documentation (Design) 

Appendices 

 

OpenRoads Designer 

Table of Contents 
OpenRoads Drawings .................................................................................................................................................................. 3 

File Naming Convention ........................................................................................................................................................... 4 

OpenRoads Designer - Survey ........................................................................................................................................................ 7 

Creating the Survey DGN ............................................................................................................................................................ 7 

Introduction ............................................................................................................................................................................... 7 

File Preparation ........................................................................................................................................................................ 7 

OpenRoads Explorer ................................................................................................................................................................ 8 

Control Points ........................................................................................................................................................................... 8 

Survey Details ........................................................................................................................................................................ 11 

Loading the Data Files ............................................................................................................................................................ 12 

Guard Against Re-Processing ................................................................................................................................................ 15 

Locking Down the Data Set .................................................................................................................................................... 15 

Repeat for Every Survey Data File ......................................................................................................................................... 15 

For Survey Updates ................................................................................................................................................................ 15 

https://mm.nh.gov/files/uploads/dot/remote-docs/nhdot-ce-cadd-documentation-introduction.pdf
https://mm.nh.gov/files/uploads/dot/remote-docs/nhdot-ce-cadd-documentation-microstation.pdf
https://mm.nh.gov/files/uploads/dot/remote-docs/nhdot-ce-cadd-documentation-ord-survey.pdf
https://mm.nh.gov/files/uploads/dot/remote-docs/nhdot-ce-cadd-documentation-ord-design.pdf
https://mm.nh.gov/files/uploads/dot/remote-docs/nhdot-ce-cadd-documentation-appendices.pdf


 
 

NHDOT CAD/D Connect Documentation 

ORD Survey Documentation Page 2 of 25 Last edited:  May 7, 2024 

Review Survey Data................................................................................................................................................................... 16 

Invalid Feature Codes ............................................................................................................................................................ 16 

Linear Features ...................................................................................................................................................................... 16 

Decorations ............................................................................................................................................................................ 17 

Offset Features ....................................................................................................................................................................... 17 

Control Codes ........................................................................................................................................................................ 18 

Continuous Features .............................................................................................................................................................. 19 

General Review ...................................................................................................................................................................... 19 

Report Crossing Features ...................................................................................................................................................... 20 

Address Crossing Features .................................................................................................................................................... 22 

Final Review ........................................................................................................................................................................... 23 

Creating Complex Terrain for Design Use ................................................................................................................................. 24 

Create Delta Terrain ............................................................................................................................................................... 24 

Create Complex Terrain from Delta and Survey ..................................................................................................................... 25 

 

  



 
 

NHDOT CAD/D Connect Documentation 

ORD Survey Documentation Page 3 of 25 Last edited:  May 7, 2024 

 

OpenRoads Drawings 

Before You Begin 

When a project is created most drawings are created within it.  They are “good” at the time of creation but as updates to the seed 
project are made to enhance and utilize updates to the software, as well as the knowledge of CADD staff a project’s files can 
become a little outdated if it has been a long time between when it was created and when you are working on it. 

Contact the NHDOT CADD Staff to see if your project drawings should be recreated prior to working on them.  

General Information 

Create OpenRoads Drawings - Video 

OpenRoads Designer uses Civil Tools to perform all the roadway design steps.  It is also used to create the plan, profile, and cross 
section drawings from the 2D\3D civil drawings.  Linked detail blowups can also be created from the 3D models and displayed on 
detail sheets.  A Combined.dgn is created to act as a common reference attach location for the projects Existing Drawings.  This 
Combined drawing will contain references to most of the project's OpenRoads existing base drawings needed for design.  This 
drawing will be Reference Attached to each design drawing with Live Nesting so that all the base drawings will be seen from just 
one attachment. 

Check the seed file before proceeding nh-seedORD-design.dgn..  

OpenRoads Designer drawings are seeded with 2 DGN models a 2D Default, as well as a 3D Default-3D. 

It is imperative that the proper DGN model (Default model typically) be active when following the documentation.  It is also 
suggested that the recommended drawings be attached to the Combined.dgn prior to working in any individual dgn. The Combined 
drawing has been pre-attached to the other design drawings with Live Nesting.  This would not be possible if the combined drawing 
had a project number in its name.  When attaching files in ORD always attach the Default model to the Default model, the Default-
3D model(s) will automatically be attached.  In MSC use the File Naming Convention Chart to determine which model to attach.  
For many drawings you will attach the Default model to view the 2D cells and linestyles but some need the Default-3D model 
attached so clipped information is not seen or because Survey or Existing Terrain linear features are only 3D. 

If you add a project number to the Combined dgn you will need to attach it to your other drawings when you open them. (and 
remove references to the Combined) 

Most drawing files are created when the project is created.  Contact the CAD/D staff if your project does not contain most of these 
files.  Existing dgns should all be in the Cadd\OpenRoads\ directory, all the other proposed design files can also reside in the 



 
 

NHDOT CAD/D Connect Documentation 

ORD Survey Documentation Page 4 of 25 Last edited:  May 7, 2024 

Cadd\OpenRoads\ directory or sub folders can be created for each design alternative. These sub folders should not be added to 
Reference file paths so drawings from other folders are not referenced accidently.  The use of the - in the drawing names helps 
separate the Civil dgn files from native MicroStation files.  The project cfg file's Reference file paths can be edited if drawings are 
stored in subdirectories that need to be referenced by others. 

File Naming Convention 

File Type Name Format Description Reference Attachments 

   Model 
to Ref 

Reference 
Description 

Logical 
Name 

OPENROADS 

Detail 12345-E-Detail 
Contains Linear and Point Features – Linear 

features are Civil. Point features are Graphical 
(Microstation Cells) 

3D 
Linear and Point 

Features 
-e-det 

Drainage & 
Utilities 

12345-E-
Drainage 

Exist. Drainage Detail Extracted from 12345-
Survey or 12345-E-MX-Survey-Topo 

D-3D Existing Drainage -e-drn 

Drainage & 
Utilities 

12345-E-Utilities 
Utility Features Extracted from 12345-Survey or 

12345-E-MX-Survey-Topo 
D-3D 

Existing Generic 
Points 

-e-gen 

Env 
Features 

12345-E-Env 
Copied ENV MicroStation lines converted to 

linear features for Cross Section labels 
D-3D 

Environmental 
delineation 

-e-env 

Row 
Features 

12345-E-ROW-
Lines 

Copied ERL MicroStation lines converted to 
linear feature for Cross Section Labeling 

D-3D 
Existing Right-of-

Way 
-e-row 

Detail 
12345-E-

FieldCheck 
Linear and Point features draped on Existing 
Terrain. Text should be brought to 12345etxt 

D-3D 
Field Trip 

Information 
-e-fc 

Combined Combined 

Empty drawing containing reference 
attachments to the Projects Existing drawings. 
Used to reference all existing drawings with a 

single attachment – Used in ORD – Live Nest = 
1 

   

Delta 
Terrain 

12345-E-Delta-
Terrain 

Created to be used as a place holder in the 
12345-E-Terrain 

3D  
 
 

Existing 
Terrain 

12345-E-Terrain Combined Terrain file from various sources 3D Exist Terrain -e-ter 
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OPENROADS – SURVEY 

Survey 12345-Survey 
For Survey Processing will include Terrain 

Model 
3D Survey -sur 

Survey 12345-Geom-PP Plan Prep Alignments D Geometry -gpp 

Survey 
12345-E-MX-
Survey-Topo 

For Survey Transfer from MX – Linear and 
Points are civil features. 

D-3D 
Linear and Points 

Features 
 

Survey 
12345-E-MX-

Terrain 
For Survey Transfer from MX D-3D Terrain from MX  

Survey 
12345-E-MX-

Trav 
For Survey Transfer from MX – Traverse points D-3D Traverse from MX  

Survey 
12345-E-MX-
Survey-Linear 

For Survey Transfer from MX – used on older 
projects 

D-3D 
Linear Detail 

Features 
e-lin 

Survey 
12345-E-MX-
Survey-Points 

For Survey Transfer from MX – used on older 
projects 

D-3D 
Point Detail 

Features 
e-pts 

OPENROADS\PRELIMINARY 

Layout 12345_Layout 
Create reference lines for pavement and lane 

tapers, linked existing ep’s, traced drive edges, 
or any other lines created for point controls 

D Prop Layout -p-lay 

Earthwork 12345-Earthwork 

Create closed shapes to clip terrains and apply 
Surface templates for exist material like 

Pavement, Muck, Rock, Topsoil, Unsuitable 
material for Sections and quantities 

D 
Earthwork 
Modeling 

-ear 

Geometry 12345-Geometry OpenRoads Alignments to show on Plans D Geometry -geo 

Corridor 12345-P-Corridor 
Corridors, Civil Cells, and possibly Drives.  It 

may be necessary to develop corridors in 
separate drawings. 

D-3D Prop Corridor -p-cor 

Drainage & 
Utilities 

12345-P-
Drainage 

Proposed Drainage information D-3D Prop Drainage -p-drn 

Drainage & 
Utilities 

12345-P-Utilities Proposed Utilities Information D-3D Prop Utilities -p-utl 
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Drive 12345-P-Drives 
Driveway Cl, Civil Cells, and corridors – small 

Side Roads also 
D-3D Prop Driveways -p-drv 

Supers 
12345-P-

SuperElevations 
SuperElevation Sections and Lanes – can 

create separate for each corridor 
-- 

Prop 
SuperElevatons 

-p-sup 

Cross 
Section 
Detail 

12345-XS-Detail 
Cross-Section Detail Ticks in Plan View used 
for annotation cross section drawings. Use a 

separate drawing for each Alignment 
-- XS Detail -xs-de 

ROW 
Features 

12345-P-ROW Proposed ROW Lines and Labels D-3D Prop ROW -p-row 

Proposed 
Terrain 

12345-P-Terrain 
Construction Surfaces – Design and Subgrade 

for Sections and export to LandXML 
-- Prop Terrain -p-ter 

      

Composite 
Terrain 

12345-
Composite-

Terrain 

Composite terrain - Design merged with 
Existing terrain. Can be used with Proposed 

Drainage & Utilities drawings. 
--   

 

 

Create Drawings and Attach References to the Combined Drawing 

Files that were recently created from the seed project have predefined logical names attached to the Default model so the logical 
name will be defined when attaching them as a reference file.  This can be set under model properties.  Open the Combined.dgn 
and attach all Existing files including the etxt file from the PRJ\ directory.  The Combined dgn has already been attached to the 
other project dgns with live nesting, so when you open other drawings you should see the existing detail already referenced.  If 
you create a new dgn you will need to attach the Combined with live nesting set to 1.  When attaching files always attach them 
with the Default model active and attach the files Default model and it will automatically attach the Default-3D models.  The 
exception is the Survey.dgn it only has one model so attach its Default (3D) model to the Default model of the Combined and it 
will be attached to both. 

When working in a dgn, attach only the drawings needed.  For example, the Superelevation drawing(s) will only ever need to be 
attached to the corridor dgn files and the Profile cut sheets drawings.  No other drawings need to work with that information so do 
not attach them to every drawing.  XS Detail, XSections, Layout, and the EarthWork are other drawings that only need to be 
attached for specific purposes to specific drawings. 
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OpenRoads Designer - Survey 

Creating the Survey DGN 

Return to Index 

Introduction 

This is the first of three sections for processing survey data to create a Survey/Terrain drawing. 

The focus of this page is to import the Control Points and to dump the Survey Data files into a new Survey Drawing.  Any Rod 
Height adjustments will trigger OpenRoads to reprocess the data and any edits to the survey data will be lost.  Therefore, all Rod 
Height adjustments must be applied immediately before locking the data down. 

File Preparation 

Create an OpenRoads directory under the Project's Cadd folder if one doesn't already exist.  Copy files from the folder where 
Survey stores project data to the Project's OpenRoads directory.   

Start OpenRoads Designer. 

Set the Workspace to NHDOT. 

Select the WorkSet for this project.  If a WorkSet needs to be created, then provide the project name and number to Bill Caswell 
to create it.   

Create and open a new 12345-Survey.dgn using the NH_Survey_Seed_3D.dgn seed file. 

OpenRoads Designer Workflow 

Direct your attention to the very top left of the OpenRoads Designer interface.  There is a pull-down box to set the OpenRoads 
Workflow.  Set this to Survey for survey processing. 

Underneath the Workflow/Title Bar are the Ribbon Tabs.  Each Ribbon Tab triggers a different Ribbon.  Most of the tools for 
processing a survey are found on the Analysis Ribbon. 
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OpenRoads Explorer 

Explorer functions as a detail manager of everything OpenRoads.  It's the technical liaison or access portal to your drawing, files 
and specifications.  Explorer is located on 5 of 9 Ribbons of the Survey Workflow and is integral to Survey processing.  The Explorer 
panel offers 7 tabs, most of the Survey processing may be accessed from the Analyze tab. 

  

Control Points 

A video is available to help explain this process.  

Control Points will likely be delivered via a text file (.csv format).  To load 
this file, use the OpenRoads Explorer and expand the Survey tab (as 
shown at left). 

In the main body of the Survey tab, expand the Survey Data > Default 
> Field Books folders (as at right). 

Right Click the Field Books for a pop-up menu.  Select the New.... Right 
Click on the newly created field book (probably called Field Book 1) and 
select Properties.  In the Properties panel, change the Name to 12345-
Survey. 

If there is a field book already, you can rename it to 12345-Survey 

Next, Right Click the 12345-Survey folder for a pop-up menu.  Select 
the Import > File Using Text Import Wizard... option. 

From the Select File panel, navigate and select the text file containing 
the Control Points (*.csv) and Click Open.  This results with a Text 
Import Wizard panel.  This Wizard's sequence is identified by a 
progression of tabs and the initial tab is Define text file type (example 
shown below).  

 

file://///dot.state.nh.us/apps/CADD/CADD/Training/NHDOT-CONNECTTrainingVideos/nh_ord_survey_01-control-points.mp4
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The first row of text in the sample above presents the order of data used in the following lines.  This information will be valuable in 
the near future; however, it does not represent the raw data that is the purpose of this file.  Therefore, the initial row of actual data 
for this example starts on the second row in this case.  Change the Start Row value to 2.  If all goes well, the first row of displayed 
text should now be the first row of actual data.  Beware of double space data files.  Also confirm that the Data Type is set to 
Delimited. 

Click Next to advance to the Define delimiters for records found tab.  From here check the appropriate Delimiters box for this data 
file.  The proper Delimiter selection will change the display of data to table format and now separated by columns. 

Click Next to advance to the Define column formats tab (example shown below). 
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Notice that all the column headings are default titled as Skip.  The chore now is to assign the appropriate column headings.  
Remember that first initial row of text that defined the data file's order, the line(s) that we just directed to ignore.  It contained the 
necessary information for this step (most important, in the proper order).  Left Click on a column heading to select.  Click a second 
time for a pop-up menu with all the possible heading options.  Mandatory heading assignments must include: 

• Northing 

• Easting 

• Elevation 

• Point Name (shot number) 

• Code (traverse point identification) 

Change all but the last column heading (for this example) to match the initial row of text from the file.  There is no option of File for 
the last column, Skip is appropriate in this case. 

Select Finish to import the text file.  A prompt will ask to create a tiw file, select No. 

Click Fit View to see the locations.  Now is a great time issue the Save Settings command. 
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To display the point numbers for the traverse points, go to Drawing Production tab, Element Annotation, 

 

 

Survey Details 

The Survey Details window shows the data associated with the items selected 
in the Survey tab of OpenRoads Explorer.  To open the Survey Details panel, 
select the Details button found on the Analysis ribbon (one of three possible 
ribbons). 

Expand the 12345-Survey field book of Explorer to show the categories of 
available data.  The details presented on the Survey Details window will vary 
depending on what category is selected in the OpenRoads Project Explorer. 

ALL Point Features will include all the observations in the survey regardless 
of whether they are Survey Setup Points, Point Features or Linear Features. 

ALL Linear Features reports just the Linear Features of the Field Book.  Each record represents a single linear feature.  The 
observations have been specifically coded in the field data recorder with Link Codes that establish that the feature is a line instead 
of only a collection of points. 

ALL Observations will show all survey shots as lines connecting the Survey Setup to the Target observations. 
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Data in the Survey Details window can be arranged and sorted by Right-Clicking on a column heading and then selecting the 
desired option from the Pop-Up menu.  Also, when a single observation is selected the location of that observation is Spot 
Shadowed in the Graphics Window. 

 

Loading the Data Files 

A video is available to help explain this process. 

Before loading any Data Files, check that the Annotation Scale is set to the appropriate scale.  Do this from the Drawing Scales 
portion of the Drawing ribbon.  

 

Note: Cells cannot be rotated, scaled, or moved until the processing rules have been turned off 

 

From the Survey tab of Explorer, expand the Survey Data > Default > Field Books > 12345-Survey folders.  Select the 12345-
Survey folder similar to Control Points section above. (also shown to the right) 

Survey data files have a .RW5 file extension.  To add one to the drawing, from a Windows File Explorer, Left-Click/hold and drag 
it over the selected 12345-Survey folder of Explorer.  Note that it might be necessary to load the files in a particular order.  The 
Survey Section should supply that information upon delivery. 

file://///dot.state.nh.us/apps/CADD/CADD/Training/BentleyCONNECTTraining/NHDOT_Connect-training_Survey_02-SurveyDataFiles.mp4
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In anticipation that subsequent Survey files may have duplicate observation numbers, it 
is important to tag the observation numbers of each survey Data File with a unique 
identifier.  It is advantageous to avoid any observation from getting re-sequenced.  Use 
the Crew Identification code of the Survey data file name such that points continue to 
correspond with the field book notes. 

To accomplish this, start by selecting All Observations of the 12345-Survey field book 
from the Survey section of Explorer.  Next, open the Survey Details panel to review the 
output of what is selected in Explorer.  The Survey Details panel is shown below. 
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 While working with the Survey Details panel, sort the Name column to be Ascending.  Now select every detail observation of this 
data file.  To do this, use the Selection column to the left of the first data column (the first data column should be the Name column 
by default).  All cells of every observation should highlight when selected as intended (shown above).  Be sure that Control Points 
have not been selected too. 

Now, Right-Click in the highlighted area of the Selection column.  Select Edit Selected Items > Name from the popup menu to get 
a Text Input panel (shown above).  Place input focus in this Text Input panel and enter the prepending text followed by the Plus 
(+) sign.  The Plus sign will direct the text to prefix the original observation Name (aka the Shot Number).  Click the green button 
of the Text Input panel to apply the prepend.  Check the edit before moving on. 

Click Fit View to see the results.  Now is a great time issue the Save Settings command.  

Both the Observation Lines and the Traverse Lines can be toggled OFF from the Display for the 12345-Survey field book.  From 
the Survey tab of Explorer, uncheck the boxes for ALL Observations and ALL Setups to accomplish this.  
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Guard Against Re-Processing 

All Rod Height adjustments must be applied immediately and the Data Set Locked Down from re-processing.  If a Data Set is re-
processed, then any general edits made prior will be lost.  Therefore, check the following items before Locking Down the Data Set. 

Review the data of the ALL Observations folder (of Explorer) using the Survey Details panel.  Look for unusually high or low Rod 
Heights.  The most common rod heights range from 5' to 8.5'.  Acceptable values range from 0' to 25'.  This chore is easily 
accomplished by sorting the Rod Height column and checking the extreme values. 

Field crews have the ability to include notes or messages in the Survey data file.  These notes are found in the Description column 
of the Survey Details panel while reviewing the ALL Observations folder.  The easiest message to decipher is an alert of rod height 
corrections.  Simply apply any corrections to the rod height values in the Rod Height column for the observation(s) noted.  Scan 
all observations for these notes and repeat. 

There is no replacing a visual check of the Terrain's Contours.  Despite processing edits have yet to be applied, inspection of the 
contours will quickly present a bad Set-Up or Rod Height.  Most rod height anomalies are more easily found by reviewing the 
contours of the terrain model.  Contours can be made visible by changing the Feature Definition of the Terrain to 
PP_Exist_Contours.  Identify any issues and address immediately.  

Locking Down the Data Set 

To lock down a Data Set, from the Survey tab of Explorer, expand the Survey Data > Default > Field Books > 12345-Survey > 
Data Files folders.  Under the Data Files folder will be entries for every Data File (.RW5) loaded.  Select the Data File to be locked 
down and then right click it for a pop-up menu.  Select Properties to get a Properties panel.  From the Properties panel, change 
Process Observation Rules from True to False.  

Repeat for Every Survey Data File 

After stabilizing the Data Set by locking it down, drag and drop each additional survey data file onto Explorer so it is added to 
12345-Survey 1.  Continue to tag the observation numbers of each survey with a unique identifier.  Make Rod Height adjustments 
and then Lock the Data Set down.  Repeat until done. 

For Survey Updates 

probably put the new data in a reference then edit any old data that overlaps.  Then once the old data is cleaned up, discard the 
reference file and bring the new data into the survey file and process it as normal. 
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Review Survey Data 

Return to Index 

This is the second of three sections for processing survey data to create a Terrain 
drawing.  

The focus of this page is to adjust the data to its most accurate representation of the 
field.  This includes and is not limited to closing gaps and overlaps, creating and 
adjusting offset features as well as addressing crossing features.   

Do not proceed with this page if the Survey Data sets have not been locked down 
yet.  Because from this point on, any edits made will be lost if the data is re-processed. 

Invalid Feature Codes 

In the OpenRoads Explorer, expand the ALL Point Features folder (as shown at right). 

Look for Point Features displayed in Red.  These are observations in the survey file 
which are not associated with Feature Definitions.  The Red entries that represent 
Survey Setup Points are normal and do not need to be addressed.  All others should 
be corrected.  Refer to the survey field book notes for shot clarification. 

Repeat the process for Linear Features.  A video is available to demonstrate this 
process. 

Linear Features 

A video is available to help explain this process. 

Observations need to be reviewed to ensure that they are not only included but 
grouped with other points of the same string.  The inclusion and associating of points 
to their intended feature is controlled using Link Codes that are assigned in the field 
data recorder.  These codes delineate the beginning and end of linear features as 
well as the extent(s) of horizontal curvature.  There are also various Link Codes 
available for closing a string to its starting point.  All point observations should have 
the Link Code set to None. 

file://///dot.state.nh.us/apps/CADD/CADD/Training/BentleyCONNECTTraining/NHDOT_Connect-training_Survey_03_InvalidPoint.mp4
file://///dot.state.nh.us/apps/CADD/CADD/Training/BentleyCONNECTTraining/NHDOT_Connect-training_Survey_04-LinkCodes.mp4
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Select the ALL Point Features folder from the OpenRoads Explorer.  Use the 
Survey Details window and sort the Name column in Ascending Order.  This 
column shows the order that the observations were taken. 

Next, scan the Feature Name column for consecutive observations of the same 
feature code.  We assume that all consecutive observations are included in that 
string unless told otherwise.  The corresponding Link Code column should define 
the extent of the feature as well it's curvature.  Check the data and add missing 
Link codes or correct wrong Link codes in the Link Code column where 
necessary.  Confirm the feature extents by using the survey field book notes.  Also 
be aware of missing observations.  Shot Numbers should be consistent and 
progressive. 

 

 

Decorations 

A video is available to help explain this process. 

Information associated with Survey Observations may be toggled on the Display with the use of 
Decorations (Analyze ribbon).  This information includes and is not limited to Point Names, Field Codes 
(including Start/End point tags) and Point Elevations.  Decorations have a Zoom tolerance and they 
disappear when Zoomed to far out.  Control Decorations from the Analysis ribbon. 

Offset Features 

In addition to notes announcing rod height corrections, messages may also describe details to create Offset Features.  These 
directions require interpretation to craft a Control Code that will generate a new Feature.  This entry must be added to the Control 
Codes cell of the first observation of the source feature.  A sample message found in the Survey data file might look something 
like this: 

203 CR TC 0.05 0.50 

Breaking down this example, the 203 is the signal that an Offset Feature is intended.  CR is the feature label of the Source Feature.  
TC is the label of the Offset Feature to be created.  The next two values are the Offset distances measured from the Source 
Feature.  Traditionally, these are written in the order of vertical offset followed by the horizontal offset. 

file://///dot.state.nh.us/apps/CADD/CADD/Training/BentleyCONNECTTraining/NHDOT_Connect-training_Survey_05-Decorations.mp4
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In the Survey Details panel, Click twice (not the same as a Double Click) in the first Control Codes cell of the Source Feature.  
When done as intended, a button with 
three dots (...) should appear at the 
right end of the cell   

Click on this button with three dots to 
get the Control Codes panel shown at 
left. 

The body of the Control Codes panel 
(under the menu buttons) is a table for building Control Code data.  Click the 
Add button to add a default data entry row below the table header. 

Click on the Control Codes cell of the new data entry (currently the default value 
is JoinPoint).  From the drop down menu select New Template.  Next, place input 
focus in the Value cell of the new entry row (to the right of the New Template 
Control Code just set).  Use the note from the Survey data file to build the Control 
Code Value, use the following format: 

The label of the new Offset Feature; space; the Horizontal Offset; space; the 
Vertical Offset. 

If negative values exist, then it is important to also carry them through.  Using the sample note from above it would look like this: 

TC 0.50 0.05 

When done, a small pencil symbol will appear in the left cell of this new data 
entry row (left of the cell set to New Template).  This pencil symbol operates 
as a button, click it to lock these values.  Then Click Accept to send the code 
to the Control Codes cell of the Survey Details panel.  Once again, scan all 
observations for these notes and repeat. 

Control Codes 

A video is available to demonstrate this process. 

While on the topic of Control Codes, it is possible that existing entries will require corrections or adjustments.  This can include 
direction and magnitude of offsets as well as string label adjustments.  Be on the lookout for Control Codes that are not set to New 
Template. 

file://///dot.state.nh.us/apps/CADD/CADD/Training/BentleyCONNECTTraining/NHDOT_Connect-training_Survey_06-ControlCodes.mp4
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To edit a Control Code (similar to the above section, Offset Features) click twice in the Control Codes cell of the Survey Details 
panel.  Once again, do not Double Click.  When done as intended, a button with three dots (...) should appear at the right end of 
the cell.  Click on this button with three dots to get a Control Codes panel similar to that shown at right: 

This time the data entry row is populated with the existing Control Code Value.  Edit this Value as necessary.  After adjusting the 
Value, click the Pencil Button in the left cell of this data entry row.  Then click Accept to send the revised Value to the Control 
Codes cell of the Survey Details panel. 

Continuous Features 

A video is available to demonstrate this process. 

The heart of a road survey happens to be the road.  These roadway features will yield a smoother and more accurate terrain when 
like features are joined together.  This effort eliminates both overlapping and gapping of continuous features regardless of how 
many pieces they were surveyed in the field. 

First, use the Element Selection tool to select a roadway feature.  Each string selected of that feature will highlight and display its 
extent.  In the Graphics Window, navigate to each end and evaluate whether or not joining is appropriate. 

To join ends, use Element Selection again to select the element that contains the end point to move.  With AccuSnap toggled ON, 
grab/hold the Move manipulator and drag it to the point that it is being joined too.  Release the grab/hold only when AccuSnap 
engages.  Warning, a missed joining will null the edited point's elevation.  Check periodically and verify that moved points are not 
nulled.  Move to the next roadway string and repeat. 

General Review 

Let's take a moment to comment on the software being used.  Be aware that OpenRoads is not yet ubiquitous and does not always 
work as intended.  These are the annoyances that have been identified so far: 

• Some common Link Code sequences freak out associated Control Code Templates.  Try to either toggle or move Link 
Codes among observations of that feature to properly recognize the Control Code.  Re-inputting or tweaking the Control 
Code may also scare it straight.  Expect much frustration. 

• Some features generated by a template from a feature with curvature will double back and cross itself at some observation 
points.  Angles greater than 90 degrees may force the template generated feature to cross its parent feature 4 times and 
itself once for just one observation.  So far eliminating curvature is unfortunately the best solution.  Expect much frustration. 

• The CloseShape Link Code should be used in extreme cases only.  Because it extrapolates an observation, it is highly 
vulnerable to compounded errors.  It also has no potential of reflecting the accurate elevation of its calculated observation.  
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From an editing standpoint, any command that inserts a new point into a line segment that was used to construct the original 
CloseShape feature will likely launch the extrapolated observation to a totally new location.  If one does not see the change 
jump, then one might believe that new resting position is valid.  CloseShape should only be used for the back side of 
buildings that are obscured from view and where the generated elevation is not as critical. 

Regardless of this instability of OpenRoads, scan the drawing for data collection anomalies.  This includes and is not limited to the 
following: 

• Missing information such as Tops of Curb, Tops of Retaining Walls and Tops of Stone Walls:  These features should have 
a corresponding top.  If necessary, make up a Control Code Template so none of these features goes topless. 

• Offset Features projected to the wrong magnitude and/or direction:  This could be due to the Control Code being mis-
entered by the field crew.  Or it could be due to the associated Link Code sequence causing interference (just mentioned 
above). 

• Directional Features going the wrong way (such as Hedges, Curbs and Rock Outcroppings):  Use the Transpose Linear 
Feature tool from the Context Sensitive Menu to flip the feature's direction.  This will also be used for any string that the 
linestyle is upside down.  See Address Crossing Features for more explanation of this command. 

• Integrity of Curvature:  It is difficult in the field to anticipate how some of the Link Codes will react or are influenced by their 
observation sequence.  Look for unexpected bulges in a feature or cords where arcs would likely be.  Refer to Aerial imagery 
to verify feature curvature. 

• Crossing Features:  The next two sections deal with Crossing Features, however a preemptive attack doesn't hurt.  

Report Crossing Features 

All field surveys are vulnerable to crossing strings and hopefully the processor (yourself) can prioritize and adjust the 
features accurately.  To generate a crossing features report, from the Terrain ribbon select Reporting > Report Crossing 
Features.  The stepping arrow allows the toggle of reporting options if Report Crossing Features is not the current default. 

Before the report can be generated, the panel shown at left will appear however, all 
required information is addressed by the Heads-Up Prompt. 

 The first prompt asks to Select (a) Terrain Model Element from the active Graphics 
Window.  Next, agree to use an Elevation Tolerance and finally what the threshold value 
should be.  When an Elevation Tolerance is applied, only the features whose elevation 
difference exceeds the Elevation Tolerance value will be reported.  Results are presented 

in the Terrain Crossing Features Report shown below.  In addition, red circles appear in the Graphics Window at every intersection 
identified in the report. 
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Every record on this report represents a crossing of two Features.  A Left-Click on any record will select that crossing and highlight 
the record in Blue (shown above).  Both Elevations of the record also come into focus.  Any elevation that is accompanied by a 
padlock symbol appears to indicate that feature was created by a Control Code template (very little functionality is available for 
these crossings).  Simultaneously in the active Graphics Window, the line segments of both features will highlight in colors 
strategically synchronized to match the columns in the report. 

The Feature Types Pull-Down controls which Feature Types are included in the report.  All of the Feature Types are reported by 
default. 

The Zoom To button will automatically Pan and Zoom the active Graphics Window to the location of the selected Crossing 
Features. 

The In View button is a toggle that limits the report to only the Crossing Features that are currently visible in the active Graphics 
Window.  When On, the report is dynamically linked to the view's extents. 

The Export... button opens the Civil Report Browser of the current report.  This browser offers all of the Bentley Reporting 
functionality. 
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Address Crossing Features 

Systematically review every Crossing Feature and determine an educated solution.  Ignore all feature crossings that include Bridge 
related features, these features are excluded from the generation of the Terrain.  A Right-Click on any Crossing Feature Record 
will present a Pop-Up menu with 7 possible options that may be used to address that particular conflict.  The 7 options are: 

1. Delete Feature 1 
2. Delete Feature 2 
3. Insert a Point into both Features at a defined Elevation 
4. Insert a Point into both Features at an average Elevation 
5. Insert point from Feature 1 into Feature 2 
6. Insert point from Feature 2 into Feature 1 
7. Automatically Fix Elevations 

The Automatically Fix Elevations option is intended for non-production projects, please don't use that. 

Be aware that some elements do not play well with these commands.  For example, feature links that are generated with the Close 
Link Code are likely to fumble. 

Not all situations are easily addressed by the above options.  Additional editing tools are available by using the Element Selection 
tool on the feature to manipulate.  Once the element is selected, hovering the pointer over it to display the Context Sensitive menu 
shown below.  More information about the Context Sensitive menu is available in this video. 

 

Some crossing situations may involve two equally legitimate lines that accidently 
intersect.  In order to salvage both lines, one or part of them simply needs to be nudged 
a little bit.  This is done by either moving the entire feature or just one of it's points to a 
new (and common sense) physical position to eliminate an unintended crossing.  
Hopefully it is easy to identify which feature is in need of adjustment. 

The third button of this menu (shown above with focus) issues the Move Point Along 
Linear Element command.  This command allows one to slide a point along the line 
segment it once defined.  The Elevation can be locked to its original value or may be 
linearly interpolated (or extrapolated) from the reference line segment.   

The point can be selected from the dropdown menu of the Tool panel or by selecting 
the point from the active Graphics Window.  Fortunately, any point on the drawing may 
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have the Survey Shot Number shown on the display.  Refer to Decorations for more detail about showing point numbers.  If the 
point is on a selected string, then the Link Code Manipulator is added to the standard Manipulators. 

The last button of this menu that is useful is the Move Linear Feature tool (eighth button from the left).  Just identify a Reference 
Data Point and then the new location for that point.  The whole feature displaces with this point. 

Breaking Features apart is best accomplished by adjusting the Link Codes of the observations presented in the Survey Details 
window when viewing the All Point Features report. 

Abandoning observations is best accomplished by deleting observations presented in the Survey Details window when viewing 
the All Point Features report.  Adjust all the Link Codes for those features as necessary. 

The best way to Null observations and keep their horizontal presence intact is to locate the observations on the Survey Details 
window when viewing the All Point Features report.  From there, change the Terrain Model Attribute property of the point to Do 
Not Include. 

Any edit made to a Crossing Features will dynamically update the Terrain Crossing Features Report and the Graphics Window.  If 
the terrain model contours are displayed, they will update as well.  Ideally, every feature crossing has a fix. 

Final Review 

Turn the Contours ON.  Do a visual scan of the project drawing for contouring anomalies.  What we are looking for is not obvious 
until we see it.  Fix anything you find.  For examples of manipulating the display of terrains to show contours or triangles, check 
out this video. 

In an effort to avoid repetitive deficiencies of the raw field data.  Plan Preparation should communicate to the Chief of Surveys and 
Mapping any errors and omissions that are found in the field data so that it can be relayed to the Crew Chief of the Survey Crew 
assigned to the task. 
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Creating Complex Terrain for Design Use 

This process has two parts, the first will create a delta terrain file, this is a Null place holder terrain for future updates to the terrain 
model. The second will create a complex terrain, so if there are future updates to the survey, the design teams will not have to 
reset their active terrain.   

Create Delta Terrain  

Create and open a new drawing 12345-E-Delta-Terrain.dgn using the NH_SeedORD_Design.dgn.  This file should be in the 
Survey folder.  Set the WorkFlow to OpenRoads Modeling.  From the Home ribbon, set the Design File Model to the Default-3D 
model.  

Attach the 12345-survey.dgn as a reference.  

Now under the Terrain tab, select drop down Additional 
Methods, Create Delta 

Once selected, set Delta Method – Terrain Model to Plane, 
To Plane – 0.000, Feature Definition – 
NH_Exist_Boundary,  

Name – EB-Null and following the prompts on your screen. 

 

You can now Save Settings, then Save and exit the Drawing. 
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Create Complex Terrain from Delta and Survey 

Open the drawing 12345-E-Terrain.dgn.  This file should be in the Openroads folder   Set the WorkFlow to OpenRoads Modeling.  
From the Home ribbon, set the Design File Model to the Default-3D model.  

If a terrain model is already in the file check to see if it is a Complex terrain.  Update it with the new survey terrain.  If the complex 
has lidar then set the Survey terrain to Merge so it clips out the lidar triangles in the area.  If it is not complex delete it.   

Attach the 12345-survey.dgn and 12345-E-Delta-Terrain.dgn as a reference files. 

Under the Terrain tab, select drop down Additional Methods, Create Complex Terrain Model. 

 

 

 

 

. 

This will bring up another dialog box, you will want 
to add your terrain models, selecting original terrain 
model first and appending the delta terrain, set your 
feature definition to NH_Exist_Boundary, with a 
name Existing-Terrain, then click Finish.  This will 
create a complex terrain model in the file. 


